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About this Document 
 

This document was created for the GSAK 201 Event sponsored by SLAGA 

(https://coord.info/GC781AB) event.  

 

In this class, we will not spend time going over the GSAK 101 material. If you need a refresher in 101, 

contact Major134; and, he will send you a digital copy of the syllabus for that class. There is enough 

201 material to cover and we will not have time to cover subjects from the 101 class. It will be 

assumed that you have GSAK already installed. You MUST have the latest version of GSAK installed. To 

make sure you are on the most current version, please go to Tools>Options, Advanced tab and make 

sure you have the "Check for patches" box checked. If you are on the most current version it will be at 

least 8.7.1.28. Version 8.7.0.0 is NOT current and many bugs have been fixed as well as features added 

since that version was released, some of which may affect topics covered in this class. 

 

In the class we will first give an explanation of the subject matter and follow it with challenges that a 

user may face and offer solutions detailing how to overcome the challenges. Questions during class 

are welcome and encouraged. 

 

In this document you will see words or phrases that are in bold text. Those generally will refer to 

window titles, labels on windows, etc… Basically something that needs to stand out or be found on the 

screen will be bold. 

 

You will also see the following icons that are used to make it easy to find different items in the 

document: 

 

This icon refers to additional information. It will be used to explain a point that may be 

confusing as you walk through the steps of an objective. 

 

This icon also refers to additional information but is a bit more important. Generally these are 

warnings that could be “gotchas” if you are new to the process. 

 

This icon will signify the beginning of an objective.  

 

 

What you should bring to class: 

1. A laptop with the most current version of GSAK already installed (8.7.1.28 as of this 

writing). 

2. Pen and paper for notes. 

3. A flash drive (not required but might be helpful). 

4. GSAK201.gpx (included with this material) loaded into a GSAK database called GSAK201. 

5. Questions! 
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Class Materials 
 

In addition to this syllabus, several files should be included in the zip file for the class. If you don’t have 

these files please let us know and we will get them to you. 

 

GSAK201.gpx 

AddTextToUserLog.gsk 

SetCorrFlagCurrentFilter.gsk 
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1.0 Finding and Installing Macros 
 

Macros are a very powerful tool to use with GSAK. They can, and will, extend its already vast 

capabilities. However, finding and using them is sometimes a challenge. Some of them are written by 

people who rarely put them out on the master list for all to find but there are dozens of them on the 

Master Macro Index for use by anyone. It is located here: http://gsak.net/board/MacroIndex.php 

 

You are allowed to download, install and use any of the macros on that list free of charge. Most of the 

time the usage instructions are on the macro page. If you have any questions you can post it in the 

macro support page and the author of the macro should see it and hopefully be able to answer your 

question. 

 

For this class, we will use the two macros included with the class material. 

 

Objective 1.0a: Install the AddTextToUserLog.gsk macro and the 

SetCorrFlagCurrentFilter.gsk macros 
 

1. Copy the AddTextToUserLog.gsk and SetCorrFlagCurrentFilter.gsk to your desktop. 

2. Minimize all programs until you can see your desktop. 

3. Double click on the AddTextToUserLog.gsk macro. GSAK will open and a screen will appear 

asking whether you want to Install the macro, Run the macro now or Open in macro 

editor.  

 

 

 

 

 

 

 

 

 

 

 

 

4. Make sure Install the macro is chosen. 

5. Click the Go button. GSAK will copy the macro to your macros folder and install it for you. 

6. Minimize again to show your desktop. 

7. Double click on the SetCorrFlagCurrentFilter.gsk macro. GSAK will open the same screen as 

it did on the previous macro. 

8. Make sure Install the macro is chosen. 

9. Click the Go button. GSAK will copy the macro to your macros folder and install it for you. 

  

http://gsak.net/board/MacroIndex.php
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2.0 Settings 
 

Throughout GSAK you will see many windows that have a Settings section along with Save and Delete 

buttons. It will usually look similar to the screenshot below. 

 

 
 

Any time you see this section you can choose all of the settings you want on that particular window 

and then save them by clicking the Save button. This will allow you to come back at a later date and 

choose those settings from the dropdown and not have to recreate them. 

 

Objective 2.0a: Create load settings to load a gpx file & update county, 

state and elevation 
 

In this objective, we will create load settings that will load the GSAK201.gpx file included with this 

class material and tell GSAK to update the County, State and Elevation columns during import. 

 

 
 

1. Click the File menu 

2. Click the Load GPX/LOC/ZIP… menu 

(Alternatively, you can click the open folder  on the toolbar and that will be the 

same as steps 1 and 2). 
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3. Choose the GSAK201 file from wherever you currently have it stored. Mine is located at 

“C:\Geocache\GSAK 201\GSAK201.gpx”. 

4. Choose a database that will be used for these settings. Mine is set to “GSAK201”. 

5. If Use defaults is checked then uncheck it. 

6. In the Delete file(s) when finished section choose No. (Mine is set to Yes. Ignore me.) 

7. In the Load Type section select Load file(s) if it’s not already selected. 

8. In the County update section, enter YB. The “Y” will tell GSAK to update the county and the 

“B” tells GSAK to only update county if it’s blank. Without the “B” GSAK will update all of 

the caches being imported which will make the import take longer, usually unnecessarily. 

9. In the State update section, enter SBA. The “S” tells GSAK to update the state field. The “B” 

tells GSAK to only update the State if it’s blank. The “A” tells GSAK to use the state 

abbreviation. If you do not want the states abbreviated, then omit the “A” and just enter 

“SB”. 

10. In the Elevation section, enter an M. This tells GSAK to update the elevation of the cache. 

It will automatically update the elevation for caches that GSAK hasn’t already previously 

updated. 

11. Click the Save button. The Save Load Settings window will appear. 

 
12. Enter a name for your settings. Make sure it’s a name that makes sense to you so that you 

will know what it is when you need them again in the future. 

13. Uncheck the Check this box to force the file name to be saved and restored box. This 

setting tells GSAK to always use the folder and filename that we entered in Step 3 rather 

than whatever folder and file were used the last time you imported a file. 

14. Uncheck the Check this box to force the database to be saved and selected box. This will 

tell GSAK to always use the database you selected in Step 4 rather than whatever 

database might be currently opened. 

15. Click the OK button to save the settings. If you are saving settings and you are using the 

same name as previously saved settings, GSAK will ask you to verify that you want to save. 

16. Click the OK button on the Load GPX window to load the file into your current database. 
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3.0 Backup and Restore 
 

GSAK stores different data in various places. For example, it stores the cache data in a sqlite database 

in one place while storing macros, backups and application data in other places. It is easy to find 

where GSAK is storing this data and, in some cases, you can dictate where you want it stored. 

 

3.1 Backing Up Your Data 
 

The first decision to make when setting up your backup strategy is where you are going to put the 

backed-up data. There are generally three locations from which you can choose. You are not 

necessarily limited to just one of the three. 

 

3.1.1 Backup Locations 

 

A. Flash Drive 

Insert the media in a USB port and determine where it is, d:\, f:\, etc. Most computers will open a 

window that will tell you which drive letter has been assigned to the flash drive after you plug it 

into the computer. 

 

B. Computer 

Create a subfolder in a folder on your computer. I have a separate parent folder named Geocache 

and I have GSAK installed in a subfolder called “GSAK Jason” so my Backup storage folder on my 

computer is located at C:\Geocache\GSAK Jason\Backup.  

 

C. The Cloud 

There are many ways to save your backups to the cloud. For whichever way you choose, you will 

need to find out how it works and set your backups accordingly. Most commonly, you can tell your 

cloud service to backup any folder on your computer automatically without further input from 

you. It will know when a new file is created, or an old file altered, and then back it up for you. 

 

3.1.2 Backup Methods 

 

The next decision you need to make is what method(s) you will use for your backup strategy. Your 

choices are automatic and manual. Again, you can use either or both methods. Generally, automatic 

backups are sufficient for most people who only use one computer. However, there may be occasions 

that you may want to make a manual backup. 
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A. Automatic Backup 

Telling GSAK to automatically backup your data is a must. Sometimes, if you have many databases, 

it can seem to take a bit of time to shut down when you close GSAK, but it is worth the time to 

allow GSAK to make the backups. 

 

GSAK only backs up your data if something changes. So, if you only go into GSAK to look at 

something but do not change any values, when you exit GSAK will not backup the data 

automatically. 

 

To get to the window in the screenshot below, click the Tools > Options menu. You can see the 

location on the computer where the backups will be stored. Also in the Automatic Backup section 

are: 

1. Enable - This tells GSAK whether to perform the backup when you exit GSAK. 

Recommended setting: Checked 

2. Prompt - This tells GSAK to confirm that you want to perform the backup. 

Recommended Setting: Unchecked 

3. Include Images - This tells GSAK whether to backup images that you have included in your 

logs.  

Recommended Setting: If you have images then checked 

4. Frequency - This tells GSAK how often to back up your databases. If you are in and out of GSAK 

many times in a day, you may want to have the frequency set to a number higher than one. 

However, if you normally get into GSAK only once or twice a day then the recommended 

setting here is 1. 
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Objective 3.1a: Set location for automatic backups 
 

1. Click the Tools menu. 

2. Click Options in the menu that appears. 

3. If not already selected, click the General tab. 

4. Click the Browse button to the right of the path shown in the Automatic Backup section. 

 
5. A window with the folders on your computer will appear. Browse to the location that you 

want the backups to be saved. 

6. Click the OK button. Your automatic backup location is now set. 
 

B. Manual Backup 

On occasion you may want, or need, to manually backup your data to a different location than 

your automatic backups. For example, if you get a new computer and you want GSAK on the new 

computer to have the same data as your old one, you may want to manually backup. The same 

three methods discussed in 3.1.1 apply here. 
 

Objective 3.1b: Manually backup specific databases to a flash drive 
 

1. Insert a flash drive into a USB port on your computer. Once your computer recognizes it, 

make note of the drive letter assigned to the flash drive. 

2. Click the File menu. 

3. In the new menu that appears, click Backup… 

4. In the GSAK Backup file to create section on the window that appears, choose your flash 

drive and create filename for your backed-up data. Click the browse button if you wish to 

browse to the backup location. 
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5. Choose the databases that you wish to backup. 

6. Click the Backup button. GSAK will back up all the databases you have checked into the file 

that you specified in step 4. 

 

Objective 3.1c: Manually backup specific databases to your computer 
There is not really a need to go over the exact steps for this objective, as they are identical to 

the previous objective except step 4. Instead of choosing your flash drive, you will just choose a 

location on your computer. 

 

Objective 3.1d: Manually backup your entire GSAK installation 
 

1. If you wish to back up to a flash drive, insert it into a USB port on your computer and make 

note of the drive letter assigned to the drive. If you wish to just backup to the computer 

then move to next step. 

2. Click the File menu. 

3. In the new menu that appears, click Backup… 

4. In the GSAK Backup file to create section on the window that appears, choose your desired 

location and create filename for your backed-up data. Click the browse button if you wish 

to browse to the backup location. 

5. Click the Select all Databases button. All databases in the list will now be checked. 

6. Check the Save GSAK Settings check box. 

7. Check the Include grabbed images check box. 

8. Click the Backup button. All databases, images and settings will be backed up into the file 

you indicated in step 4. 

 

3.2 Restoring Your Data 
The day will come when you will need to restore data from a backup. Maybe you’ve had a hard drive 

crash or you have a new computer and want to move GSAK from old to new without recreating it all 

from scratch. 

 

Objective 3.2a: Restore databases only in a manual backup from a flash 

drive 
 

1. Insert the flash drive with your backup into a USB port on your computer and make note of 

the drive letter assigned to the drive. 

2. Click the File menu. 

3. Click Restore… in the new menu. 

4. If the location of the file you want to restore does not show up automatically in the GSAK 

Backup file to restore from section (and it probably won’t) you will have to click the browse 

button and browse to the backup file you wish to restore from. 

5. Select your backup file and a list of databases contained in the backup file will appear in the 

Databases to restore section. 
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6. If there is more than one database and you want to select them all, or clear them all, you 

can click the Select all Databases or Clear all Selected button depending on which you want 

to do. That saves you from having to click each one individually. 

7. Click the Restore button. GSAK will create a database for each of the databases you 

checked and then import the data from the backup. 

 

If you choose a database in your backup that has the same name as a current database in GSAK, 

it will overwrite that database. So, if you want to keep the current database with that name but 

also restore the old version, you must first go to the Database menu and select Rename… where you 

will be prompted to choose a database to rename and a new name for it. 

 

Objective 3.2b: Restore backup of entire GSAK installation onto new or 

rebuilt computer 
 

In the case of a new or rebuilt computer, you will need to install GSAK (including your 

registration information) and get it up to the most current patch prior to restoring the backups. 

Your GSAK license allows you to install GSAK on as many computers as you own. If you want to 

install GSAK on a computer that doesn’t belong to you, a license for the person that owns that 

computer will need to be purchased. 

 

1. Click the File menu. 

2. Click Restore… in the new menu. 

3. If GSAK doesn’t automatically put the location of where your backup files are located, click 

the browse button and browse to the correct location. One way to make this easy on 

yourself is, after setting up GSAK, use Windows to copy your backup files to the location 

that you have indicated in the Automatic Backup section on your new computer. That’s 

where GSAK will look first for the backups. 

4. In the Databases to restore section select all the databases that you wish to restore. 

5. In the Non-database items to restore section check all of the checkboxes. 

6. Click the Restore button. All the databases you selected and the settings from your 

previous installation will be restored. That includes macros, buttons you’ve added to the 

toolbar and anything else that you’ve customized along the way. 
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Objective 3.2c: Restore an automatic backup after messing up a 

database 
There will be, at some point, a time when you need to restore a backup because you have done 

something to your database that gets it so messed up that you can’t easily fix it. It is good 

practice to make a manual backup before you start experimenting with a macro or some other 

method of changing data and you are unsure about what the result will be. However, in the 

case that you don’t make that manual backup, here are the steps for restoring from one of 

your automatic backups that were created the last time you exited GSAK. 

 

1. Click the File menu. 

2. Click Restore… in the new menu. 

3. In the GSAK Backup file to restore from section, check the Select an automatic backup 

check box. The box below will fill with your automatic backup location and a new dropdown 

menu will appear to the right. The dropdown menu will be prefilled with Backup 1 through 

Backup 5. 
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4. If you want the most recent automatic backup, choose Backup 1 in the dropdown. Backup 2 

is the backup just prior to Backup 1 and Backup 5 is the oldest. Most of the time you will 

choose Backup 1. 

5. Once you choose the backup, the list of databases will appear in the Databases to restore 

section. Choose the database(s) that you wish to restore. At a minimum, you will choose 

the one that matches up with the database that you were using when your experiment 

went awry. 

6. Click the Restore button. Your database will be restored to the same state that it was in 

when the backup was made. 
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4.0 Filtering 
 

GSAK provides a very powerful tool called Filters. The purpose of a filter is to tell GSAK to only show 

you caches in a database that you want to see. It simply hides what you don’t want to see. The 

different combinations by which you can filter a database are limited only by your imagination. 

Remember, this GSAK function does not filter geocaching.com; it only filters a GSAK database you 

have populated with geocaches. 

 

You cannot cause any damage to your database with a filter. It simply temporarily hides caches 

that you don’t want to see. Feel free to experiment all you want without fear of causing harm. 

You’ll be glad you took the time to learn how to filter! 

 

The Filter window has nine different tabs on it. Select any tab and a smorgasbord of options pops up. 

There is no way to discuss all of them within the class time, so I will give four examples of filters so 

that you become comfortable using them, and then you can explore it on your own. 

 

Objective 4.0a: Find all the caches that are Difficulty 2 or higher, Terrain 

3 or higher and placed before 10/20/2012 that are type Multi and 

located in Montana. Then save the filter for later use 
 

1. Open the GSAK 201 database. 

2. Click the Filter button on the toolbar to open the Set Filter window. 

3. Select the General tab. 

4. Find Difficulty. 

5. In the dropdown menu to the right, choose Greater than or equal to. 

6. In the box to the right of the dropdown choose 2.0. 

7. Below Difficulty find Terrain. 

8. In the dropdown menu to the right, choose Greater than or equal to. 

9. In the box to the right of the dropdown choose 3.0. 

 

 

 

 

10. At the top of the Set Filter window select the Dates tab. 

11. The second option down will be Placed date. To the right of Placed date select On or 

before. 

12. Once you select On or before a calendar box will appear to the right. In that calendar 

choose 10/20/2012. 
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13. At the top of the Set Filter window select the Other tab. 

14. The top section on this tab shows all of the cache types available and they are all checked. 

On the top right corner of the section click the –All button. This will uncheck all of the 

cache types. 

15. In the same section check the check box next to Multi. 

16. A little further down the same window you will see State. In the dropdown to the right 

select Equal to. 

17. In the text box to the right of the dropdown enter Montana. 

I’m going to stop here and point out 2 important points concerning the state values 

you enter. First, the value you put here is not case sensitive. So, Montana and 

montana are the same for practical purposes. Second, if you have set GSAK to abbreviate 

states then you must enter the abbreviation MT (again, not case sensitive) instead of 

typing the entire state name.  

18. Now that we are done setting up the filter we are going to save it. Click the Save button at 

the bottom of the Set Filter window to open the Filter name to save… window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

19. Enter a name that will mean something to you and describe the filter. 

20. If you wish to save the center point you are currently using and always use it with this 

filter check the Save (and restore) current centre point with this filter check box. After 

you save a filter, it will show up in the Select a saved filter dropdown on your toolbar. 

21. Click the OK button and this window will disappear and the filter will be saved. 

22. Click the Go button at the bottom of the Set Filter window. 

 

If there are no caches that match your search criteria, then you will receive an Error Message 

that reads, “Sorry this filter contains no waypoints. Filter will NOT be set.” Remember, the 

terms waypoint and geocache are interchangeable in GSAK. Just click OK to dismiss this message. 
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When a filter is applied the caches appear in a list within the database called a subset. To 

cancel that subset and return to the entire database, click the Search menu. In the drop-down 

menu, click Cancel Filter and the normal database returns in its entirety. 
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5.0 Global Replace 
 

This is a powerful tool used to change the same field in a group of geocaches from its current value to 

a new value. For example, you might be experimenting and need to change your found status on 

caches to unfound. Instead of doing all of them one at a time, Global Replace accomplishes the task in 

just a few seconds. 

 

Objective 5.0a: Create a file for a friend with caches that you have found 

but caches your friend still needs to find 

 

You and a friend are planning a caching trip in Queeny Park. You have found most of the caches and 

your friend has found none. You want to create a database that you can load into your friends’ GPSr, 

and you want that database to show that all caches within Queeny have not been found by your 

friend. 

 

If you download the caches from geocaching.com to the new GSAK database, they will show up in the 

database indicating that they have been found by you. When you load them in your friends GPSr, their 

GPSr will think they’ve already been found. Global Replace will fix that problem. 

1. Click the Tools menu. 

2. Click the Options… menu to open the Options window. 

3. Click the Advanced tab. 

4. The Advanced tab has 2 tabs on it, Page 1 and Page 2. Make sure Page 1 is selected. 

5. In the middle of Page 1, uncheck the box for Interrogate logs for Founds/DNF. 

6. Click OK. 

7. Open the database that has the caches you want to send. 

8. Filter your database for caches that you want to send to your friend. It’s ok to have more 

caches than what you want so you don’t necessarily have to worry about it being exact. 

9. Click the Database menu at the top of the screen. 

10. Click the Global replace… menu to open the Global Replace window. 

11. On this window, you will see the word Replace with a dropdown just to the right. That is 

the dropdown that we use to tell GSAK which data we want to replace. Choose Found 

Status in the dropdown. 

12. To the right of the Replace dropdown box you will see With and another dropdown to its 

right. This is the value that we want GSAK to put into the field we chose in the previous 

step. Choose Not Found in the dropdown.  
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13. Click Replace. The Global Replace window will disappear and your caches should now 

show as Not Found. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

14. Click the File menu at the top of GSAK. 

15. Hold your mouse cursor over, or click, the Export menu item. A new sub-menu will show 

to the right. 

16. Click the GPX/GGZ/LOC file… menu item to open the Export GPX/LOC File window. 

17. Most of the time, all you need to worry about is the filename. In the Filename to create 

box you can both type the full path and filename of the file you wish to create or you can 

click the browse button and browse to the location where you want the file to be created. 

18. Click Generate. The file will be created with the name and location that you specified. This 

is the file you will send to a friend for them to import into their database. 

 

When you import a cache, GSAK will, by default, check to see if you have logged it. If you have, 

it will mark it found and add the found date to match your found log date. Simply changing a 

cache from found to not found seems simple, but because of this GSAK behavior, we must do a little 

extra work. That is the reason for step 5 in the instruction above. 

 

There may be a rare occasion where you may create a GPX file with the method described 

above and it fails when you try to load it into a GPSr. If that happens, try exporting again but 

this time, in the File Type section on the Export GPX/LOC File window, choose 1.1 instead of 1.0 in the 

dropdown. 

 

After you are done with your replace, don’t forget to go back and do steps 1-6 again, only this 

time make sure the Interrogate logs for Founds/DNF box is CHECKED. 
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Objective 5.0b: Change the Found by Me Date in all the caches to 

December 20, 2015 
 

To show a more basic use for Global Replace, let’s change the Found by me date in a group of caches 

to 12-20-2015. We are not concerned, for this objective, if you have found the caches or not. We are 

just walking through the steps for demonstration purposes. 

1. Open the GSAK 201 database. 

2. Click the Database menu. 

3. Click the Global Replace… menu to show the Global Replace window. 

4. In the dropdown to the right of Replace, choose Found By Me Date. 

5. In the box to the right of With type 12/20/2015. 

6. Click the Replace button. All caches in your current filter will now have a Found By Me Date 

of 12-20-2015 and will all be marked Found. 

7. The Global Replace window does not disappear after the replace. If you are finished 

replacing everything you want, click the Cancel button, or the red X in the top right corner, 

to make the window close. 
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6.0 Publishing Logs with GSAK 
 

Publishing logs with GSAK has a bit of a learning curve but, once you get it set up, it will likely be one 

of your favorite GSAK features. You access the Publish logs… feature under the Geocaching.com 

access menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6.1 Publish logs… 
One of the most powerful and useful features of GSAK is the ability to log your finds and your DNF’s 

very quickly. If you take some time to set this up it has the potential to save you an enormous amount 

of time logging caches. We will cover two different methods on logging caches. Each method will 

require you to set up templates that GSAK will use during the publish process. The use of templates 

enables you to have standard boilerplate text for each log type. These templates can just be literal 

text, but are more useful if you include dynamic information - which we refer to as tags. Any tags in 

your template will be replaced with actual values during the publish process. All tags are preceded by 

a percent character (%). 

 

Templates can be made for many different types of logs. However, the most common are Found it, 

Didn’t find it, Attended and Webcam photo taken. These four templates will likely take care of most, 

if not all, of the logs you will be publishing through GSAK. The other types are available but are 

generally logged via geocaching.com. 
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Objective 6.3a: Publish found it logs for caches in a filter with a simple 

template 
1. Click the Geocaching.com access menu. 

2. Click Publish logs… in the opened menu. The Publish logs window will open. 

3. In the middle of the Publish logs window you will see a button labeled Fetch. The same 

button also appears along the lower left side of the Publish logs window. Both buttons do 

the exact same thing so you can click either one now. 

4. In the menu that appears, click From filter. All the caches in your filter will be added to this 

window. If GSAK asks if you want to add all in the database, click Yes for the purposes of 

this exercise. 

5. Click the Templates button at the bottom of the Publish logs window. 

6. In the Publish Templates window choose Found it in the dropdown at the top. 

 

 

7. In the big white text box in the Template section type the following text without the 

quotes: “Thank you for hiding this cache. I appreciate it.”. 

8. Click the OK button. The Publish Templates window will save the template and disappear. 

9. Now we have to apply the template to the caches in the list. Highlight any of the caches in 

the list then, on your keyboard, press CTRL+A. This will highlight all of the caches in the list. 

10. On any of the highlighted caches, right-click with your mouse. A new menu will appear. 

11. In the new menu, click Reapply Templates. This will apply the text we just put in the 

Found it template to all of the caches in the list. 

12. Click the Publish all button. DO NOT DO THIS STEP IF YOU DO NOT WISH TO ACTUALLY 

PUBLISH THE FOUND LOGS. 

 

Published logs can only be removed or edited manually, one at a time, on the geocaching.com 

website. This can be quite a tedious task if you have many to do. Make sure you are ready to 

publish before actually clicking the Publish all button! 

 

If you want to see exactly what will get published to your found it log on Geocaching.com you 

can do the following from the Publish logs window. 

1. Right click any cache to open a new menu. 

2. On the new menu click Edit to open the Publish logs edit window. 

3. On this window, about half way down, you will see a Preview tab. Click the Preview tab. 

 

 

 

4. You should now see exactly what your log will look like on Geocaching.com after it’s 

published. 
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Objective 6.3b: Create a template that will say: “Thank you 

<OwnerName> for placing this cache. It was find number <X> out of <Y> 

today.” but automatically fill in the owner name and find numbers so that it 

doesn’t have to be done manually 
 

1. Click the Geocaching.com access menu. 

2. Click Publish logs… in the opened menu. The Publish logs window will open. 

3. At the bottom of the Publish logs window click the Templates button. The Publish 

Templates window will open. 

4. On the Publish Templates window, at the top, is a drop down that has a list of the 

templates that we can set up. In that drop down, choose Found It. 

5. Also on this window you will see a white box in which you can type your template text. 

6. In that box type the following without quotes: “Thank you “ (notice the space after the 

word “you”).  

7. From the Tags dropdown above the big text box, choose %OwnerName. This will show in 

the text box as %OwnerName. 

8. After %OwnerName type the following, with a space at the beginning, a space at the end 

and without quotes: “ for placing this cache. It was find number “. 

9. From the Tags dropdown choose %DayCount and it will appear in the text box. 

10. Type the following in the text box: “ out of “. 

11. From the Tags dropdown choose %DayTotal and it will appear in the text box. 

12. Type the following in the text box: “ today.” 

13. Your text should now look like this (without quotes): “Thank you %OwnerName for placing 

this cache. It was find number %DayCount out of %DayTotal today.” 

14. Click the OK button to save the template. 

15. Repeat steps 1-14 for the Didn’t Find it, Attended and Webcam Photo Taken templates. 

However, feel free to change the text to anything you want. If you wish the Attended and 

Webcam Photo Taken templates to be the same as your Found it template you can just 

copy and paste what you’ve already done into those templates and save them. 
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This template will tell GSAK that during publish it should replace the tags with the actual values. 

 

 
 

Objective 6.3c: Publish logs using the template above. Caches to publish 

will be retrieved from a filter you have set with the caches to be logged 
 

1. Open the GSAK 201 database. 

2. In the Select a saved filter dropdown on your toolbar choose My Found Caches (GSAK 

Default).  

3. Click the Geocaching.com access menu. 

4. Click Publish logs… 

5. In the new window that appears, click the Fetch button. 

6. In the menu that appears, click From filter. This will load all of the caches in the current 

filter into the publish window and they will show in the same order in which they are 

showing in the filter. 

7. If you wish to reorder the caches so that they will publish in the same order you found 

them, highlight the cache you wish to reorder and click either the ↑ Move or the ↓ Move 

button that corresponds with the direction in which you want to move the cache in the 

order. 

8. When you have the caches in your desired order, click the Publish all button and GSAK will 

connect to Geocaching.com and publish all of your logs for the caches you chose. 
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Objective 6.3d: Create a template that will apply the text you will enter 

into the Log section of each cache into your published log 
 

This method of logging caches is a bit less complicated in the long term, in my opinion. It allows you to 

set a template one time and never change it. If you want different text in your log you will simply 

change the Log text for that cache before you publish. A macro has been written to allow you to apply 

text to the Log section for many caches all at one time for those power trail logs that will all be the 

same. It’s called AddTextToUserLog.gsk and is available to anyone who requests it. 

 

1. Click the Geocaching.com access menu. 

2. Click Publish logs… in the opened menu. The Publish logs menu will open. 

3. At the bottom of the Publish logs window click the Templates button. The Publish 

Templates window will open. 

4. On the Publish Templates window, at the top, is a drop down that has a list of the 

templates that we can set up. In that drop down, make sure Found It is selected. 

5. Also on this window you will see a white box in which you can type your template text. 

6. In the box type the following without quotes: “%Log” 

7. Click the OK button to save the template. 

8. Repeat steps 1-7 for the Didn’t Find it, Attended, Webcam Photo Taken and any other 

template that you want to create. 
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Objective 6.3e: Manually add our log text to the Log section for the 

caches in our filter 
 

1. Open the GSAK 201 database. 

2. In the Select a saved filter dropdown on your toolbar choose My Found Caches (GSAK 

Default). 

3. Find your Notes column. It’s the one that looks like a piece of paper in the column header.  

 
4. Double click in the Notes column in the same row as one of the caches in your filter. That 

will open up the Notes window. 

5. In the Notes window there are 2 big text boxes where you can type anything you want. The 

top one is labeled User Notes and the bottom one is labeled Log Section. The Log Section 

box is the one we are interested in. 
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6. For the sake of consistency we will create the same log here that we did in Objective 6.3b. 

In the Log Section type the following without quotes: “Thank you %OwnerName for placing 

this cache. It was find number %DayCount out of %DayTotal today.” 

7. Click the Save button. 

8. You will now see a half sheet in the Notes column for the cache that has that text you just 

saved. This just indicates that there is content in the Log Section for that cache. 

9. Repeat steps 2-6 for the subsequent caches. You can copy and paste the text from the first 

one into the others. Or, if you want the log to be different just put in what you want. You do 

not have to use the tags if you don’t want to. 
 

Objective 6.3f: Publish logs using our template and apply a favorite point 

to one of our finds using the template above. Caches to publish will be 

retrieved from a filter you have set with the caches to be logged 
 

1. Open the GSAK 201 database. 

2. Click the Geocaching.com access menu. 

3. Click Publish logs… 

4. In the new window that appears, click the Fetch button. 

5. In the menu that appears, click From filter. This will load all the caches in the current filter 

into the publish window and they will show in the same order in which they are showing in 

the filter. 

6. If you wish to reorder the caches so that they will publish in the same order you found 

them, highlight the cache you wish to reorder and click either the ↑ Move or the ↓ Move 

button that corresponds with the direction in which you want to move the cache in the 

order. 

7. Choose a cache to which you want to apply a favorite point. Right click that cache. 

8. On the menu that appears, click Edit. 

9. A new window will appear that will show your template and other information. On this 

window, at the top, check the Add favorite point check box. GSAK will check with 

Geocaching.com to make sure you have favorite points to give before allowing you to 

continue. 

10. Click the OK button. 

11. Repeat steps 7-9 for any other caches that you wish to apply favorite points to. 

12. If you are ready to publish but do not wish to publish all the caches in the list, for 

whatever reason, you can publish some now and some later. To highlight the caches you 

wish to publish now, hold down the CTRL button on the keyboard and select each cache 

you wish to publish. If you wish to publish all in the window, skip to step 14. 

13. When you have all caches selected that you wish to publish, click the Publish selected 

button. GSAK will connect to Geocaching.com and publish all the logs for only the caches 

you have highlighted and apply favorite points if indicated. 

14. If you wish to publish all the caches in the list, click the Publish all button and GSAK will 

connect to Geocaching.com and publish all of your logs and apply favorite points to the 

caches you chose. 
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7.0 Corrected Coordinates 
 

Correcting coordinates in GSAK will enable you to take advantage of one of the most useful features of 

GSAK. If you solve a puzzle at home, you can enter the corrected coordinates in GSAK and, once you 

load them into your GPS, it will guide you to the new coordinates as opposed to the coordinates 

where the cache is listed. Corrected coordinates can be entered for any cache type in GSAK. 

 

There are correct and incorrect ways to enter corrected coordinates. We will cover the correct ways. If 

you choose to do it differently than shown here, you do so at your own risk. 

 

To quickly see if you have entered corrected coordinates for a cache, make sure you have the 

Corrected Coordinates Indicator column displayed. If you don’t have it displayed you can turn it on 

under Tools > Options, Display tab. 

 

 The Corrected Coordinates Indicator column will have the 

yellow triangle with the exclamation point in it. The same icon 

will show in any caches in which you have entered corrected 

coordinates. 

 

 

 

Objective 7.0a: Enter corrected coordinates 
 

1. Open the GSAK 201 database. 

2. Use one of the following methods to open the Corrected Coordinates window: 

a. Double click in the Corrected Coordinates Indicator column for desired cache. 

b. Right click cache and choose the Corrected Coordinates… menu item. 

c. Highlight cache then choose the Waypoint menu then the Corrected Coordinates... 

menu. 

3. The Corrected Coordinates window will appear with the corrected coordinates currently 

filled in the Lat/Lon box. If you have not corrected them in the past, the coordinates 

showing will be the original coordinates entered by the cache owner. 

4. In the Lat/Lon box enter the actual corrected coordinates. 

5. At the bottom of the window check the Force elevation refresh check box. 

6. Click the OK button to save the coordinates. 

 

The corrected coordinates indicator will now be set for that cache so that you can easily see that 

corrected coordinates have been entered. 
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Objective 7.0b: Delete corrected coordinates in GSAK 
 

1. Open the GSAK 201 database. 

2. Use one of the following methods to open the Corrected Coordinates window: 

a. Double click in the Corrected Coordinates Indicator column for desired cache. 

b. Right click cache and choose the Corrected Coordinates… menu item. 

c. Highlight cache then choose the Waypoint menu then the Corrected Coordinates... 

menu. 

3. The Corrected Coordinates window will appear with the corrected coordinates currently 

filled in the Lat/Lon box. 

4. Click the Delete button at the bottom. You will get a message box telling you that the 

corrected coordinates have been deleted. 

 

The corrected coordinates indicator will now be removed from that cache and the coordinates that 

will show will be the original coordinates that were downloaded from geocaching.com. 

 

IMPORTANT: No matter how you correct the coordinates there is a way to inadvertently 

overwrite them. Let’s say you correct the coordinates of a cache in database 1 but you have the 

same cache in database 2 without corrected coordinates. If you copy the cache from database 2 to 

database 1, it will copy the entire cache over, effectively wiping out the corrected coordinates in 

database 1. It would be good practice to either make sure you always copy FROM the database with 

corrected coordinates or have a database that only contains caches with corrected coordinates that 

you use as a storage location for those caches. 
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Objective 7.0c: Get corrected coordinates entered on cache page on 

Geocaching.com into GSAK 
 

Geocaching.com allows you to enter corrected coordinates on the cache page for Unknown (?) caches. 

When you do this, those coordinates will be in any pocket queries that include that cache. That, in and 

of itself, is not a bad thing. However, the file that is created by geocaching.com has nothing in it that 

indicates that those coordinates are corrected. As a result, the cache in GSAK will not have the 

corrected coordinator set after the file is imported. 

 

To set the corrected coordinates indicator do the following in GSAK: 

1. Highlight the cache in your database. 

2. Click the Geocaching.com access menu. 

3. Click the Refresh cache data… menu to display the Refresh Cache Data window. 

4. Choose Current cache only in the Scope section. 

5. Click the OK button. 

 

GSAK will update the cache with the most current information and show you a summary window. You 

can close that window and see that the cache will have the corrected coordinates indicator. 

 

Now for the confusing part. If you load that cache again from a new gpx file or pocket query, the 

corrected coordinates indicator will once again be removed. There are two ways to prevent this from 

happening: 

 

1. After you refresh cache data and the corrected coordinates indicator appears, you can open 

the Corrected Coordinates window with any method mentioned in Objective 7.0a step 2 

and then click the OK button. This is probably the easiest way if you only have a few to do. 

2. There is a macro written called SetCorrFlagCurrentFilter.gsk (included with this class 

material) that will set the corrected coordinates flag and make it so that the corrected 

coordinates will not be overwritten during a future import. This macro will run on every 

cache in a filter so make sure you filter and show only the caches you want set prior to 

running the macro. 
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8.0 Adding Buttons to the Toolbar 
 

GSAK will allow you to customize your toolbar and either add buttons that you use often, or remove 

buttons that you don’t use often. This customization is backed up when your automatic backups are 

created. 

 

8.1 Adding Predefined Buttons to the Toolbar 
 

Almost every menu item in GSAK has a predefined button also assigned to it. However, there is clearly 

not enough room for all of the buttons. So, GSAK allows us to add them as we please. 

 

Objective 8.1a: Add the Global Replace button to your toolbar 
 

1. Click the Macro menu. 

2. Click the Add Button to Tool Bar… menu to open the Customize Speedbar window. 

 
 

3. In the Categories pane select Database. 

4. In the Available buttons pane scroll down and select Global Replace. 

5. Using your mouse, grab the button to the left of Global Replace and drag it up to your 

toolbar where you want it. Once you have it where you want it, let go of it with your mouse 

and it will be placed on the toolbar. 

6. Click the OK button to save your changes. 

 

If you want to simply re-order buttons, rather than add one, just open the Customize Speedbar 

window and that will put GSAK in the proper mode. Then you can drag the buttons around the 

toolbar until you are happy with their locations. Then click the OK button on the Customize Speedbar 

window.  
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8.2 Adding Macro Buttons to the Toolbar 
If you have macros that you have installed and run often, you can configure a button to run them and 

then add that button to the toolbar. This saves you from having to go to a potentially long list of 

macros to find the one you want in order to run it. 

 

Objective 8.2a: Configure and add a button to the toolbar that will run 

the AddTextToUserLog.gsk macro 
1. Click the Macro menu at the top of the main GSAK window. 

2. Click the Button Configuraton… menu to open the Macro Button Configuration window. 

3. Under the Macro Button text, choose an unused button name. If you have never configured 

a macro button the first unused one will say 1–M1. All unused buttons will have the button 

number and then an M followed by the button number. So, if the 13th button is unused it 

will say 13-M13. 

4. In the box under Button Text enter AT. You will see in the bottom right corner a section 

called Toolbar sample. This will show you what your button will look like. If you enter too 

many characters in the Button Text, the button will not stretch and it will look odd. So keep 

it short and sweet. 

5. In the box below Button Description and Hint type in Add Text to Log Section. This is the 

text that will show when you hover your mouse over the button. 

6. In the Macro File Name box type the name of the macro. In this case it’s 

AddTextToUserLog.gsk. You do not need to put a full path to it if the macro is installed in 

the GSAK macros folder. In this case we know it is since we installed it earlier in section 1. 

7. Leave the Icon File Name box empty. If you wish to use this, you can only use BMP files and 

you must put a full path to the file. Using this will show the icon on the button instead of 

the text we entered in step 4. 

8. Click the Save button to save the settings and close the window. The macro button 

configuration is complete. Now we have to add it to the toolbar. 
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9. Click the Macro menu at the top of the main GSAK window. 

10. Click the Add Button to Tool Bar… menu to open the Customize Speedbar window. 

11. In the Categories pane select Macros (NOT Macro). 

12. In the Available buttons pane select your AT button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13. Using your mouse, grab the AT button and drag it up to your toolbar where you want it. 

Once you have it where you want it, let go of it with your mouse and it will be placed on 

the toolbar. 

14. Click the OK button to save your changes. 

 

Notice that it was specifically mentioned to select Macros and not Macro. Selecting Macro will 

give you the choices for the menu items under the Macro menu. Macros will give you the 

buttons that can be specifically configured to run individual macros. 

 

In the Macro Button Configuration window, you can see a Height and Width box with 28 set as 

the default value. You can change these values but you must be aware that ALL buttons will be 

changed to the values you set here, not just the button you are configuring. 
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8.3 Removing Buttons from the Toolbar. 
So, you’ve added a bunch of buttons to your toolbar and now you have decided that you don’t need 

them all there any longer. Removing them is simple. 

 

Objective 8.3a: Remove the Global Replace button from the toolbar 
 

So, you’ve had the Global Replace button on your toolbar for a while now and you realize that you 

never really use it. So, you want to remove it to make room for something that you use more often. 

1. Click the Macro menu. 

2. Click the Add Button to Tool Bar… menu to open the Customize Speedbar window. 

3. The toolbar at the top is now in edit mode. Grab the Global Replace button that we added 

it earlier and drag it down to just below the toolbar. You will see it disappear and the spot 

on the toolbar will no longer have a button. 

4. Click OK on the Customize Speedbar window to save the changes. 


